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Ver:   7.2.7 EW 25679/2712 
The source browser could become unresponsive if the .pbi or .pbd file was corrupt. 
 

Ver:   7.2.7 EW 25507/2562 
Evaluating expressions that produced out-of-bounds results could cause the Debugger to crash. The 
problem affected the Watch windows and some plugins. 
 

Ver:   7.2.7 EW 25653/2662 
Dragging and dropping an item within the Workspace window could lead to a crash. 
 

Ver:   7.2.7 EW 25643/2667 
The 'Replace with' field in the 'Replace in Files' dialog box no longer has a string size limit. 
 

Ver:   7.2.7 EW 25650/2699 
Saving the contents of the Interrupt Log window to a file now includes the Execution Time field. 
 

Ver:   7.2.7 EW 25555 
If a program contains several different unnamed structure types with equally named and typed 
fields, but with different offsets, the debugger can display some of the structure types incorrectly. 
 

Ver:   7.2.7 EW 25535/2689 
Too long texts in a tooltip could cause a crash. Now a text that does not fit is truncated. 
 

Ver:   7.2.5 EW 25411/2556 
Cspybat might fail to handle paths that contain spaces. 
 

Ver:   7.2.4 EW 25456/2542 
A dependency on loading user arguments variables made that any failure on loading a user argument 
variable prevented subsequent loads, this is now corrected. 
  

Ver:   7.2.4 EW 25310/2477 
Batch builds ignore the 'Tools>Options>Project>Stop build operation on' option. 
 

Ver:   7.2.1 EW 25317/2486 
In some situations toggling a breakpoint in an editor window might create a new breakpoint instead of 
just toggling an existing one. 
 

Ver:   7.2.1 EW 25312/2478 
The For larger projects (~100 files under version control) the IDE could fail to update the Subversion 
status. 
 

Ver:   7.2.0 EW 24980/2303 
The Call Graph window might show incomplete results due to a change in the source browser output 
format. 
 

Ver:   7.2.0 EW 24948/2283 
Sometimes it is impossible to check in files with a file path relative to $PROJ_DIR$ when using the 
SCC interface. 
 

Ver:   7.2.0 EW 23115/1272 
Variables in The Live Watch window might be marked red even though their values remain unchanged 
through several updates of the window. 
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Ver:   7.1.5 EW 25071/2336 
The message box caused by an assertion is not modal. This means that it is possible to execute other 
commands, which could lead to a crash. 
 

Ver:   7.1.5 EW 25052/2319 
If stack usage tracking is enabled, failure to read stack memory might cause false stack overflow 
warnings. 
 

Ver:   7.1.5 EW 25023/2314 
Project connection files are no longer removed unintentionally from projects when you open a 
workspace. 
 

Ver:   7.1.5 EW 25019/2309 
The source browser is not always re-enabled after having been disabled. (The source browser can 
temporarily be disabled, for example during a build or when a debug session is started). 
 

Ver:   7.1.5 EW 24972/2291 
The Start Debugging and Stop Debugging commands cause resource leaks. 
 

Ver:   7.1.5 EW 19444/802 
If you define "class xxx" or "struct xxx" and variable "xxx" in the same scope, it is impossible to 
evaluate variable "xxx" in the Watch/Quick Watch/Locals windows. 
 

Ver:   7.1.4 EW 25037/2313 
Sometimes the automatic update of the Code Coverage window fails to mark executed statements as 
executed. 
 

Ver:   7.1.4 EW 25034/2300 
If "--code_coverage_file" is specified as a debugger extra option, it is appended at the end of the 
autogenerated cspybat command line line. This is incorrect because it is a general option, it must be 
placed before the "--backend" option. 
 

Ver:   7.1.4 EW 25007/2306 
Expanding a pointer to function in the Watch/Quickwatch window might cause the debugger to crash. 
 

Ver:   7.1.4 EW 24974/2292 
The SFR Setup window leaks resources. 
 

Ver:   7.1.4 EW 24954/2284 
Data Log graph settings in the Timeline window are not preserved. 
 

Ver:   7.1.4 EW 24795/2254 
An unreliable connection to the SCC server could prevent the SCC client from checking in/out files. 
 

Ver:   7.1.2 EW 24906/2265 
When processing a file with a large number of lines, the source browser might take a very long time, 
thus preventing the build tools from working. 
 

Ver:   7.1.2 EW 24878/2238 
When code completion is used in an editor window, member/function/variable names are not correctly 
completed with the item selected from the completion list. 
 

Ver:   7.1.2 EW 24875/2268 
The Workspace window leaks icon resources. 
 

Ver:   7.1.2 EW 24868/2237 
The Call Stack window leaks resources. 
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Ver:   7.1.2 EW 24827/2274 
Long function names are truncated in the Call Stack window. 
 

Ver:   7.1.1 EW 24709/2185 
Adding a C-RUN rule or changing the default C-RUN action caused the IDE to crash when the C-RUN 
windows were grouped together. 
 

Ver:   7.1.0 EW 24421/2012 
It is not possible to view a variable in the Watch window as a 64 bit signed or unsigned integer, as the 
Watch window is missing the Show As>64-bit Signed and 64-bit Unsigned commands. 
 

Ver:   7.0.6 EW 24759/2206 
Using the $WS_DIR$ argument variable in the project file could cause iarbuild.exe to exit abnormally. 
 

Ver:   7.0.6 EW 24719/2197 
The SymList plugin should be loaded by default but is not. 
 

Ver:   7.0.6 EW 24717/2208 
You must click in an editor window before using shortcuts in it, if you just closed another editor 
window. 
 

Ver:   7.0.6 EW 24660/2144 
When accessing files in the project, Windows could display the error message: "The requested 
operation cannot be performed on a file with a user-mapped section open." The reason was that the 
source browser could lock the files. 
 

Ver:   7.0.6 2128 
Code completion can now be manually invoked (using the Edit menu or Ctrl+Space), even if the cursor 
is not placed after '->', '::' or '.'. Invoking code completion by typing a period ('.') still works, but using 
Ctrl+Space is the recommended method. 
 

Ver:   7.0.6 EW 24641/2145 
The progress information when examples were downloaded was incorrect in the Japanese language 
mode. 
 

Ver:   7.0.6 EW 24599/2132 
Some objects of a class/struct/union type might be impossible to expand (there is no '+' sign in front of 
them). 
 

Ver:   7.0.6 EW 23821/1611 
Files that are not members of a project can be check out but not check in again using the IDE SCC 
integration. 
 

Ver:   7.0.6 EW 21235/2174 
Argument variables related to the build output (e.g., $TARGET_DIR$ and $TARGET_BNAME$) will 
now be expanded correctly when the output file itself is missing. 
 

Ver:   7.0.5 EW 24607/2125 
The menu command View>Cores was disabled even though the project was configured for 
asymmetrical multicore debugging. 
 

Ver:   7.0.3 EW 24589/2115 
In some rare cases data is shown as code in the Disassembly window. 
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Ver:   7.0.3 EW 24593/IDE-2117 
Sometimes SFR groups might not be shown in the Register window even though they are defined in 
the .ddf file. 
 

Ver:   7.0.3 EW 24581/IDE-2110 
In the simulator it is not possible to read registers using a # prefix (for instance the #PC) in the 
execUserExecutionStopped macro. 
 

Ver:   7.0.3 EW 24552/IDE-2099 
In some cases, using a macro to save target memory to a file might cause the debugger to crash. 
 

Ver:   7.0.3 EW 24451/IDE-2062 
When the HTML-format linker map file is opened, it is not automatically updated even though the 
option 'Scan for changed files' is enabled. 
Map files in text format are automatically updated. 
 

Ver:   7.0.3 EW 24399/IDE-1997 
Very rarely, adding a variable to the Watch window might cause the debugger to exit abnormally. 
 

Ver:   7.0.3 EW 24339/IDE-2032 
The Sampled Graphs window displays the time in tooltips in seconds (s) instead of milliseconds (ms). 
 

Ver:   7.0.0 EW 23383/IDE-1170 
Lines over a certain length could not be viewed in their entirety in the Batch Build dialog box. 
 

Ver:   6.6.9 EW 24474/IDE-2025 
If a file is opened in the text editor using a Windows hard link, and then saved, the hard link will be 
replaces by a regular file path. 
 

Ver:   6.6.9 EW 24468/IDE-2052 
Auto indent now only plays a sound to indicate that the file is read-only. 
 

Ver:   6.6.8 EW 24317/IDE-2013 
It is now possible to redefine a default key binding. However, it is not possible to permanently remove 
a default key binding; it will be restored in the next session. 
 

Ver:   6.6.7 EW 24375/IDE-1984 
Removing of a breakpoint while the debugger is executing might make the debugger unstable. 
 

Ver:   6.6.6 EW 24313/IDE-1948 
If an externally built ELF/DWARF object file contained a struct declared in a function scope prototype, 
the debugger could exit unexpectedly while downloading the file. 
 

Ver:   6.6.6 EW 24306/IDE-1941 
Selecting the option 'Options>C/C++ Compiler>Preprocessor>Ignore standard include directories' 
caused the source browser to stop working. 
 

Ver:   6.6.6 EW 24304/IDE-1940 
Increased the maximum number of functions in the Go To Function dropdown menu from 200 to 2000. 
 

Ver:   6.6.6 EW 24292/IDE-1933 
When displaying the interrupt log in the Timeline window, the interrupt duration was always displayed 
in time units, even if Time Axis Unit was set to Cycles. 
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Ver:   6.6.6 EW 24274/IDE-1929 
If you created a source file using the "File>New File" command, code completion did not work until you 
closed and reopened the file in the editor. 
 

Ver:   6.6.6 EW 24266/IDE-1967 
Defining the 'main' function in a non-standard way that is not 'int main(int argc, char *argv[])' or 'int 
main(void)' might limit source browse information. 
 

Ver:   6.6.6 EW 23383/IDE-1170 
Lines over a certain length could not be viewed in their entirety in the Batch Build dialog box. 
 

Ver:   6.6.5 EW 24242/IDE-1918 
When replacing text by clicking "Replace All" in the "Replace in Files" dialog box, truncation did not 
work correctly. That meant that if the replacement string was shorter than the text to replace, the 
resulting file would contain extra, unwanted characters at the end. 
 

Ver:   6.6.4 EW 24201/IDE-1907 
Auto completion, the "Go to function" button, and tooltip information did not work in IAR Embedded 
Workbench products based on the common components version 6.6.2 and 6.6.3. 
 

Ver:   6.6.4 EW 24190/IDE-1904 
An .svd file that contains extremely long lines might cause the IAR Embedded Workbench IDE to stop 
responding. 
 

Ver:   6.6.4 EW 24027/IDE-1858 
Using the argument variables $TARGET_BNAME$ and/or $TARGET_BPATH$ when specifying the 
linker output file could lead to unexpected termination. 
 

Ver:   6.6.4 EW 20933/IDE-374 
If a project that was created using IAR Embedded Workbench installed together with visualSTATE is 
opened in IAR Embedded Workbench installed without visualSTATE, a warning referring to an 
"unknown tool 'Coder'" is no longer displayed. 
 

Ver:   6.6.3 EW 24183/IDE-1882 
When the debugger stops at a breakpoint, the "Go to function" button and the insertion point position 
on the status bar are not visible until you click in the editor window. 
 

Ver:   6.6.2 EW 24172/IDE-1897 
The source browser did not recognize a mixed case file extension (e.g. *.Cpp) as a valid extension for 
a C++ source file. 
 

Ver:   6.6.2 EW 24170/IDE-1893 
In some cases IarBuild failed to expand argument variables based on environment variables 
($_ENVVAR_$). 
 

Ver:   6.6.2 EW 24124/IDE-1880 
End of file (EOF) condition of stdin in the Terminal I/O is now handled correctly, making _read(), 
fread() and similar functions to return the proper status. 
 

Ver:   6.6.2 EW 24116/IDE-1875 
Include paths that did not match the capitalization of the actual files and directories were ignored by 
the Source Browser. 
 

Ver:   6.6.2 EW 20007/IDE-57 
To interrupt the execution of a C-Spy macro, press and hold down Ctrl+Shift+.(period) a few seconds. 
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Ver:   6.6.1 EW 24079/IDE-1874 
Find/Replace in files sometimes failed to find matches in files that contain utf-8 encoded text. 
 

Ver:   6.6.1 EW 24053/IDE-1865 
If you started and stopped the debugger several times during one IAR Embedded Workbench session, 
a serious memory leak could lead to abnormal termination. 
 

Ver:   6.6.0 EW 24010/IDE-1824 
Trailing blanks were sometimes not trimmed from the name of the linker output file, which could cause 
problems when the extension ".out" was considered to be different than ".out ". 
 

Ver:   6.6.0 EW 23984/IDE-1792 
Using the argument variables $DATE$ and $USER_NAME$ in, for example, a file path could lead to a 
"Standard multi tool failed to establish output file name" error. 
 

Ver:   6.6.0 EW 23948/IDE-1755 
Auto-indent always inserted spaces even when the option "Insert tab" was selected. 
 

Ver:   6.6.0 EW 23420/IDE-1644 
Because linker input files were sorted case-sensitive, the output files could differ from linking to linking, 
even though the linker input files were identical, binary-wise. However, the output files were correct in 
all cases. 
 

Ver:   6.6.0 EW 23317/IDE-1323 
The editor now uses different colors and fonts for the preprocessor information. 
 

Ver:   6.6.0 EW 23263/IDE-1322 
Expanding a huge array in a debugger watch window could cause an out-of-memory crash. Now array 
expansion is halted after 5000 elements, but can be continued manually. 
 

Ver:   6.5.11 EW 23991/IDE-1785 
The source browser did not recognize target-specific extended keywords for M16C, RL78, V850 and 
RX. If there were more than 100 keywords in a source file, the source browsing information was not 
generated (too many errors). 
 

Ver:   6.5.9 EW 23934/IDE-1743 
Sometimes, when performing the internal integrity check, the flash loader caused a false alarm. This 
resulted in a long list of incorrect warnings in the flash0.trace file. 
 

Ver:   6.5.9 EW 23917/IDE-1709 
Executing a Reset command while debugging could lead to a crash if the Stack window was open. 
 

Ver:   6.5.8 EW 23810/IDE-1609 
"Go to definition" failed to find functions defined in .cpp files if they were defined with extern 'C' 
linkage. 
 

Ver:   6.5.7 EW 23875/IDE-1667 
Printing more than 16,000 characters to the Terminal I/O window produces incorrect output. 
 

Ver:   6.5.6 EW 23829/IDE-1605 
In some situations, IAR Embedded Workbench might incorrectly stop reporting build errors if you retry 
Project>Make several times in a row without making any changes to source files. This is, of course 
incorrect. The errors are still there even if they are not reported, and the build will not be successful 
despite being reported as such. 
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Ver:   6.5.5 IDE-1595 
Running IarBuild.exe in a Jenkins environment can fail with a "Build aborted" message. Building the 
same project with IarBuild.exe without Jenkins works fine. 
 

Ver:   6.5.4 EW 23757/IDE-1569 
If a function was defined using the "static" keyword but declared without it, or vice versa, a "Go to 
definition" command for this function failed. 
 

Ver:   6.5.4 EW 23648/IDE-1474 
If a search for a regular expression in the Find in Files window produced a result containing line 
breaks, only the first line was displayed. 
 

Ver:   6.5.4 EW 23741/IDE-1497 
Auto-indentation could in sometimes fail to indent a line directly after a preprocessor directive. 
 

Ver:   6.5.3 EW 23743/IDE-1498 
Undoing an auto indentation command applied to a source block required an undo for every line in the 
block. Now a single undo command reverts the entire block. 
 

Ver:   6.5.3 EW 23726/IDE-1473 
In some cases incorrect project settings caused the debugger to issue an error upon starting, only to 
exit unexpectedly after the error was corrected. This no longer happens. 
 

Ver:   6.5.3 EW 23714/IDE-1476 
Setting a breakpoint in a uC/OS-III project could make C-SPY unresponsive. This has been corrected. 
 

Ver:   6.5.3 EW 23711/IDE-1472 
Projects with many include files and/or many #define's could make the source browser slow. This has 
been corrected. 
 

Ver:   6.5.3 EW 23704/IDE-1466 
If a Project>Project Connection command added an include path to the Additional include 
directories field on the Project>Options>C/C++ Compiler>Preprocessor options page, and that 
path contained any environment variables like "$PROJ_DIR$", they were expanded and the path was 
saved that way. Now paths are saved unconverted. 
 

Ver:   6.5.3 EW 23688/IDE-1471 
The source browser no longer issues repeated warnings if undefined environment variables are part of 
any include path. 
 

Ver:   6.5.3 EW 23669/IDE-1475 
The Go to Definition and Go to Declaration commands did not find names located in comments or 
inactive source code. 
 

Ver:   6.5.3 EW 23525/IDE-1455 
Because of a problem with processing paths containing "..\\.." patterns, some include files could be 
displayed twice in the Workspace window. 
 

Ver:   6.5.3 EW 23463/IDE-1450 
It was impossible to place the insertion point to edit names of variables in undocked windows. 
 

Ver:   6.5.3 EW 23234/IDE-1297 
The editor's Open include file command did not work correctly for include files excluded from the 
build. 
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Ver:   6.5.3 IDE-1404 
When using the scroll box in some windows (for example the Trace window), the window contents are 
now visible during the scrolling. 
 

Ver:   6.5.3 IDE-1367 
Files involved in multi-file compilation (MFC) builds are now ordered alphabetically based on the 
filename (instead of on the full path). This makes it more understandably deterministic which file will be 
the useful object file resulting from an MFC compiler invocation. 
 

Ver:   6.5.2 EW 23620/IDE-1441 
Executing a Debug>Memory>Restore... command to non-writable memory gave an incorrect error 
message. This message is correct now. 

 

Ver:   6.5.2 EW 23619/IDE-1443 
Some problems that could cause the IDE to freeze terminating a debug session have been corrected. 

 

Ver:   6.5.2 EW 23612/IDE-1420 
The source browser generated incomplete information when the --preinclude directive was used. This 
has been corrected. 

 

Ver:   6.5.2 EW 23610/IDE-1419 
In previous versions of IAR Embedded Workbench, source browser and build status updates stopped 
when the IDE was not the foreground process. This behavior is now controlled by an option in the 
Tools>Project dialog box. 

 

Ver:   6.5.2 EW 23596/IDE-1414 
Sometimes, setting a breakpoint in highly optimized code could cause IAR Embedded Workbench to 
exit unexpectedly. This has been corrected. 

 

Ver:   6.5.2 EW 23434/IDE-1349 
Expressions in the Live Watch window which did not evaluate to a C/C++ lvalue did not update during 
execution. This has been corrected. 

 

Ver:   6.5.2 EW 23432/IDE-1344 
Because of a missing notification, the Source Browser window could display "Collecting information..." 
forever. Now it is updated as soon as the source browse information is ready. 

 

Ver:   6.5.0 EW 23564/IDE-1394 
The text editor failed to automatically detect the character encoding that was used, because of missing 
DLLs. This has now been corrected. 

 

Ver:   6.4.7 EW 23514/IDE-1380 
Creating or editing configurations in the Memory Configuration dialog box when running a session in 
Japanese could cause IAR Embedded Workbench to exit unexpectedly. This has been corrected. 

 

Ver:   6.4.7 EW 23500/IDE-1366 
The commands Next/Previous Bookmark now wrap at the beginning and the end of the document. 

 

Ver:   6.4.6 EW 23474/IDE-1359 
In some cases stopping execution in the heavily optimized code could cause the debugger to exit 
abnormally. This has been corrected. 
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Ver:   6.4.6 EW 23471/IDE-1358 
Executing the context menu command "Force" on a vacant area in the "Forced Interrupt" window 
caused the debugger to exit unexpectedly. This has been corrected. 
 

Ver:   6.4.6 EW 23454/IDE-1353 
The "Project>Import File List..." dialog box in the Japanese version of IAR Embedded Workbench did 
not show *.ewp files by default. This has been corrected. 
 

Ver:   6.4.6 EW 23451/IDE-1354 
It is no longer possible in the Memory Configuration Window to enter an end address that is lower than 
the start address. 
 

Ver:   6.4.6 EW 23441/IDE-1361 
When the downloaded application does not contain any C variables (with static storage duration), the 
I-jet driver will no longer issue a warning about finding no variables in memory designated as RAM. 
 

Ver:   6.4.6 EW 23428/IDE-1345 
Strings and C/C++-style comments were not colored in assembler files. This has been corrected. 
 

Ver:   6.4.6 EW 23330/IDE-1356 
C-SPY could misinterpret certain flags in an ELF file and consider some read-only segments writable. 
This could interfere with memory integrity checks when launching a debug session. This has been 
corrected. 
 

Ver:   6.4.5 EW23409/IDE-1333 
The text editor will now correctly reload files that were opened as read-only. 
 

Ver:   6.4.5 EW23403/IDE-1332 
The "Memory Restore" command did not work in some cases for the Motorola format. This has been 
corrected. 
 

Ver:   6.4.5 EW23378/IDE-1328 
Defining a typedef and a struct using the same identifier caused the source browser to stop working. 

This has been corrected. 
 

Ver:   6.4.5 EW23341/IDE-1332 
The Memory window lost focus when editing memory content after entering one unit. This has been 
corrected. 
 

Ver:   6.4.5 EW23336/IDE-1330 
Sometimes the localized (Japanese) strings were garbled in the Watch window. This has been 

corrected. 
 

Ver:   6.4.5 EW23334/IDE-1331 
The horizontal scrollbar in the editor window did not show all of a very long line. This has been 

corrected. 
 

Ver:   6.4.5 EW23261/IDE-1317 
It is now possible to restore a srec/hex file via the debugger using the "Debugger>Memory>Restore" 
command. 
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Ver:   6.4.5 EW23085/IDE-1267 
Specifying the "General Options->Output->Executables/libraries" path with a trailing space caused IAR 
Embedded Workbench to quit unexpectedly. This no longer occurs.  
 

Ver:   6.4.4 EW23343/IDE-1325 
A project in an initial stage (with missing source files) may crash the source browser when doing a 
Rebuild. This has been corrected.  
 

Ver:   6.4.2 EW23324/IDE-1318 
Input via a non-Latin keyboard (e.g. Cyrillic) was not working. This has been corrected. 
 

Ver:   6.4.2 EW23285/IDE-1319 
The editor could become sluggish when operating on files located on a slow network drive. Speed 
has been improved by changing the behavior of file monitoring (i.e. detecting file changes made 
externally). 
 

Ver:   6.4.2 EW23283/IDE-1320 
The IDE could crash when a leaf was double clicked in the Code Coverage window, because of a 
missing path in the editor view.  This has been corrected. 
 

Ver:   6.4.2 EW23278/IDE-1305 
Caret color is now set to white if the background is dark, and black otherwise. 
 

Ver:   6.4.2 EW23276/IDE-1303 
The editor no longer tries to identify special comments like '//!' or '///' (e.g. Doxygen or javadoc 
comments).  Now everything after '//' is handled as a normal C++ comment. 
 

Ver:   6.4.2 EW23265/IDE-1301 
The Find/replace operation generated a sound for each replacement. Now a beep is emitted during a 
replace operation only when the document is read-only. 
 

Ver:   6.4.2 EW23253/IDE-1296 
Reloaded editor files were incorrectly scrolled to the beginning. They are now opened at the 
expected location. 
 

Ver:   6.4.0 EW23157 
Setting the editor font to "Terminal" resulted in "Courier" instead. This has been corrected. 
 

Ver:   6.4.0 EW23144 
Opening the Symbolic Memory window when debugging an RVDS-built application that contains 
union data members without a location attribute, caused C-SPY to exit unexpectedly. This has been 
corrected. 
 

Ver:   6.4.0 EW23111 
A failed post-build step was not included in error count displayed in the status bar. This has been 
corrected. 
 

Ver:   6.4.0 EW23041 
Setting/clearing breakpoints on the lowest line in the Disassembly window by clicking on the leftmost 

column now works correctly in all cases. 
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Ver:   6.4.0 EW22949 
The following construction: 
 
#define INCLUDE <stdio.h> 
#include INCLUDE 
int main(void) 
{ 
...... 
 
could cause the source browser to fail to find the definition of 'main'. This no longer occurs. 
 

Ver:   6.4.0 EW22820 
The Timeline window was not updated correctly when data log breakpoints were enabled/disabled 

during a debug session. This has been corrected. 
 

Ver:   6.4.0 EW22519 
The context menu command "Go to definition" could fail if the function was defined in a header file. 
This has been corrected. 
 

Ver:   6.4.0 EW22502 
Copying an expression in the Live Watch window and pasting it into the Watch window could make 
the debugger exit abnormally. This no longer occurs. 
 

Ver:   6.4.0 EW22368 
If a source file contained a preprocessor directive that was surrounded by a parentheses, the list of 
functions might be empty when you clicked the Go to function button in the editor window. This has 
been corrected. 
 

Ver:   6.4.0 EW22351 
The source browser could cause the IDE to become unresponsive if the license for the compiler could 
not be verified. This no longer occurs. 
 

Ver:   6.4.0 EW21962 
Printing a multipage selection in the editor window that did not start at the beginning of a line 
and/or end at the end of a line could fail to print all selected content. This has been corrected. 
 

Ver:   6.4.0 EW21643 
Editor line numbers exceeding 5 digits were partly displayed outside the line number column. This 
has been corrected. 
 

Ver:   6.4.0 EW19865 
The following code caused the "Go to function" button to malfunction: 
 
#ifdef SOMETHING 
if (condition_1) { 
#elif 
if (condition_2) { 
#endif 
 
This has been corrected. 
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Ver:   6.3.18 EW23123 
C-SPY could exit unexpectedly when stepping through heavily optimized code containing cross calls. 
This has been corrected. 
 

Ver:   6.3.17 EW23081 
Choosing Debug>Memory>Save/Restore while the target was running could produce incorrect data. 
These operations are now disabled when the target is running. 
 

Ver:   6.3.17 EW23031 
It was impossible to set the offset on the Project>Options>Debugger>Images page to a value greater 
than 0x7FFFFFFF. This is possible now. 
 

Ver:   6.3.17 EW22969 
Previously IAR Embedded Workbench did not remember a connection to some source control 
systems (for example ClearCase) between sessions. This has been corrected. 
 

Ver:   6.3.16 EW23009 
The Interrupt Log Summary window could show uninitialized content directly after debugging session 
started. This has been corrected. 
 

Ver:   6.3.15 EW22923 
In some cases executing multiple Page Up commands in the Disassembly window could cause the 
code to be disassembled incorrectly. This has been corrected. 
 

Ver:   6.3.15 EW22901 
The contents of the Statics window were not filtered when it was opened after the start of a 
debugging session. The correct contents were not displayed until after a window update (for 
example after executing a step command). This has been corrected. 
 

Ver:   6.3.15 EW22868 
Trying to load a file that contains modules produced with gcc could cause the IDE to crash. This has 
been corrected. 
 

Ver:   6.3.14 EW22920 
The Source Browser failed to browse include files specified with an absolute path. This has been 
corrected. 
 

Ver:   6.3.14 EW22893 
The IAR Embedded Workbench integration with Subversion could misinterpret some Subversion 
version 1.7.x messages, which resulted in the internal error: 
 
"SVN: Internal Error: SVN_Status - did not find file". 
 
This has been corrected. 
 

Ver:   6.3.12 EW22795 
Function-like macros with zero parameters caused the Source Browser to lose the definition 
following the macro. 
 
For example, after this definition: 
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#define MACRO() macro_body 
 
x in the following lines would not be recognized the Source Browser: 
 
MACRO() 
int x; 
 
This has been corrected. 
 

Ver:   6.3.12 EW22784 
The debugger might close unexpectedly during long trace acquisition (several hours) in the time line 
window. This no longer happens. 
 

Ver:   6.3.12 EW22775 
Parsing large ORTI description files could cause the ORTI plugin to fail with a "memory exhausted" 
message. This has been corrected. 
 

Ver:   6.3.12 EW22710 
If a path for the build log file contained an argument variable (like "$PROJ_DIR$) and the "Overwrite 
old file" option was selected, the log was still appended to the existing file. This has been corrected. 
 

Ver:   6.3.10 EW22766 
In some cases, single stepping or running to breakpoints when the Call Stack window is open could 
make the IDE unresponsive. This has been corrected. 
 

Ver:   6.3.10 EW22764 
If you used two or more monitors, ending a debug session with the main IDE window open on one 
monitor but the Disassembly window on another monitor, IAR Embedded Workbench could 
terminate unexpectedly when you restarted the debug session. This has been corrected. 
 

Ver:   6.3.10 EW22667 
In Watch windows, pointers to ARM Thumb functions now correctly show the function name. 
 

Ver:   6.3.10 EW22609 
Files in editor panes were not always restored to the correct panes. This has been corrected. 
 

Ver:   6.3.10 EW22528 
A minor memory leak when using the source browser has been fixed. 
 

Ver:   6.3.10 EW22494 
The date and time format used in the Product Info dialog was operating system dependent. It now 
has a fixed format using UTC time to make it easy to compare the contents of different installations. 
 

Ver:   6.3.10 EW19961 
Evaluation of a cast expression in C-Spy, containing a plain char, such as "(char *)42" when the target 
program does not use the plain char type anywhere, could result in crash. This has been corrected. 
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Ver:   6.3.10 EW19781 
The name of the currently opened workspace is now displayed along with the IAR Embedded 
Workbench name in the Windows Taskbar and Task Manager 
 

Ver:   6.3.6 EW22665 
Using the    setSimBreak macro to set a "write" breakpoint ("W") resulted in breakpoints set as "read" 
("R") instead. This has been corrected. 
 

Ver:   6.3.5 EW22610 
The checkmark in front of the "Mixed-Mode" entry on the Disassembly window context menu had 
been lost. It is back now. 
 

Ver:   6.3.3 EW22496 
The Stack window no longer crashes upon opening when, under certain circumstances, C-Spy has 
insufficient information about target system stacks to display stack information as intended. 
 

Ver:   6.3.2 EW22463 
The command 'Undo Checkout' in the Version Control System submenu for SCC did not work. This 
has been corrected. 
 

Ver:   6.3.1 EW22409 
If the Watch window was not already open, executing "Add to Watch" on a selection in the editor 
window just opened the Watch window without adding an entry to it. Now it does. 
 

Ver:   6.3.1 EW22401 
A build problem where argument variables, in some circumstances, were not expanded relative to 
the configuration actually being built has been corrected 
 

Ver:   6.3.1 EW22394 
A malfunctioning automatic horizontal scroll feature when dragging a selection from the editor 
window to the left or the right has been turned off. 
 

Ver:   6.3.0 EW22342 
If two or more IAR Embedded Workbench toolchains (for different microcontroller architectures) 
were installed in the same directory, and some of the toolchains were only available in English, 
launching IAR Embedded Workbench in a non-English language meant that the Information Center 
was not available for English-only toolchains. This has been corrected. 
 

Ver:   6.1.7 EW22305 
The dialog box used for choosing a directory from the Find in Files dialog box had wrong dialog box 
title and button name. This has been corrected. 
 

Ver:   6.1.6 EW22203 
Errors and warnings detected when building were reported as twice as many they really were. This 
has been corrected. 
 

Ver:   6.1.6 EW22178 
Recursive definitions of a preprocessor macro no longer causes IAR Embedded Workbench to 
terminate abnormally. 
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Ver:   6.1.6 EW22127 
Large and complex projects no longer cause the IAR Embedded Workbench source browser to freeze. 
 

Ver:   6.1.6 EW22076 
The IDE command “Stop Build” now works properly when it is applied to pre- or post-build actions 
when they are started in a new command shell. 
 

Ver:   6.1.5 EW22182 
Type definitions containing pointers to functions could produce incorrect debug information leading 
to unexpected IAR Embedded Workbench termination when the debugger was started. This has been 
corrected. 
 

Ver:   6.1.5 EW21536 
The "Go to definition" command applied to a symbol which definition was located in a conditionally 
included header file could fail. This has been corrected. 
 

Ver:   6.1.4 EW22164 
Invoking project build commands could cause the IAR Embedded Workbench to freeze under 
Windows7. This has been corrected. 
 

Ver:   6.1.3 EW22211 
The IAR Embedded Workbench IDE sometimes failed to delete temporary files named EWnnn in the 
project Obj and List directories when they were no longer needed. This no longer occurs. 
 

Ver:   6.1.3 EW22156 
IAR Embedded Workbench could leak GDI (Graphics Device Interface) objects in some cases. This no 
longer occurs. 
 

Ver:   6.1.3 EW22125 
In some cases, when using trace based data features, executing an application in the debugger over a 
long time could result in a "Runtime Error!" message and abrupt IAR Embedded Workbench 
termination. This no longer occurs. 
 

Ver:   6.1.3 EW22116 
IDE Embedded Workbench could terminate unexpectedly when changing editor font type or/and 
size. This has been corrected. 
 

Ver:   6.1.0 EW22005 
The "Project>Options>Linker>Output>Output file:" text box accepted a file path instead of just a 
filename which could lead to project building problems. This has been corrected and the option has 
been renamed. 
 

Ver:   6.1.0 EW21924 
A serious memory leak could lead to IAR Embedded Workbench abnormal termination. This has been 
corrected. 
 

Ver:   6.1.0 EW21916 
A variable declared in an assembler source file could be given an incorrect address when it was 
displayed in a Watch window. This has been corrected. 
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Ver:   6.1.0 EW21869 
Namespaces could not be used when the IAR C-SPY Debugger resolved names. This has been 
corrected. 
 

Ver:   6.1.0 EW21862 
There was a redundant warning when the flash loader checked for the presence of arguments. This 
warning is no longer issued. 
 

Ver:   6.1.0 EW21840 
Using a path containing ".." to defined output directories could make it impossible to start the 
debugger. This has been corrected. 
 

Ver:   6.1.0 EW21751 
Corrupt .wsdt and .dbgdt files in a project's settings directory could cause IAR Embedded Workbench 
to quit unexpectedly. Now, if this situation occurs, the IAR Embedded Workbench IDE reverts to 
default layouts. 
 

Ver:   6.1.0 EW21646 
A file path exceeding the _MAX_PATH Windows limit could cause the IAR Embedded Workbench to 
freeze or quit unexpectedly. Now such situatations are detected and flagged as errors. 
 

Ver:   6.0.6 EW22150 
IAR Embedded Workbench could terminate unexpectedly when reloading a project that had been 
externally modified if the project being reloaded needed to be converted to a newer version. This has 
been corrected. 
 

Ver:   6.0.0 EW19988 
Variables of array, struct, union or class type placed at an absolute address were not displayed 
properly in the Watch window family. This has been corrected. 
 

Ver:   5.8.1 EW21923 
Applying format alternative from "Trace expression window" context menu to en empty row caused 
the IAR Embedded Workbench to exit unexpectedly. This has been corrected. 
 

Ver:   5.6.3 EW21715 
Large and complex projects could cause the IAR Embedded Workbench source browser to freeze. 
This has been corrected. 
 

Ver:   5.6.3 EW21660 
Construction like 
 
extern struct ST s; 
 
could make contents of "Go to Function" window incorrect. This no longer happens. 
 

Ver:   5.6.3 EW21603 
Incorrect address of members of anonymous structs and unions was shown in the Live Watch 
window. This has been corrected. 
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Ver:   5.6.3 EW21589 
Instantiated code templates were stripped of multiple blanks. This no longer happens. 
 

Ver:   5.6.2 EW21532 
If you exited the debugger while the application was running and the option "Leave Target Running" 
is selected, an incorrect stack threshold exceeding warning was issued. This no longer happens. 
 

Ver:   5.6.2 EW21491 
Adding a file to a project will now use the current case of the file name, even if it was previously 
included in the project with another case. 
 

Ver:   5.6.0 EW21413 
Opening a context menu in the Editor window will no longer produce strange error entries in the 
Debug Log window. 
 

Ver:   5.6.0 EW21154 
Negative values of long long type greater than (2^31)-1 (absolute) can now be entered manually in 
the Watch window. 
 

Ver:   5.6.0 EW20856 
There was a problem when switching from multi-file compilation mode to single-file compilation, 
causing the error "Build error: Multiple tools write to the same file" to be issued. This problem has 
been corrected. 
 

Ver:   5.6.0 EW20276 
Breakpoints with the path not under $PROJ_DIR$ were not saved with relative paths. Paths on the 
same drive are now always saved as relative to $PROJ_DIR$, regardless where the file resides (unless 
it is actually under $TOOLKIT_DIR$, in which case it will be relative to $TOOLKIT_DIR$). 
 

Ver:   5.5.5 EW21391 
Dragging an expression containing a dereferenced function pointer onto the Memory window no 
longer causes the debugger to crash. 
 

Ver:   5.5.4 EW21255 
The source file paths retrieved from the externally built ELF/DWARF object file are now correctly 
interpreted by the debugger. 
 

Ver:   5.5.3 EW21331 
Sometimes, during downloading to flash memory, the IDE could become unresponsive. This has been 
corrected. 
 

Ver:   5.5.3 EW21301 
Sometimes, while stepping in a complex C++ program, the displayed source code location did not 
reflect the current program counter. This has been corrected. 
 

Ver:   5.5.0 EW20980 
A rare problem with downloading files in the Motorola S37 format into the wrong memory location 
has been corrected. 
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Ver:   5.4.3 EW20902 
In some cases, during initialization of the Stack plugin immediately after downloading the 
ELF/DWARF input file, the Embedded Workbench IDE exited unexpectedly. This has been corrected. 
 

Ver:   5.4.3 EW20824 
A C/C++ macro definition containing a '#' character no longer causes the IAR Embedded Workbench 
IDE to exit unexpectedly. 
 

Ver:   5.4.1 EW20780 
An '#undef' preprocessor directive not followed by a preprocessor symbol no longer causes the IAR 
Embedded Workbench IDE to exit unexpectedly. 
 

Ver:   5.4.0 EW20752 
The Embedded Workbench could crash if a large selection in the text editor was right-clicked. This 
has been corrected. 
 

Ver:   5.4.0 EW20703 
It is now possible to right-click a breakpoint in the Editor and Disassembly windows to open the Edit 
Breakpoint dialog box. 
 

Ver:   5.4.0 EW20488 
The ILINK checksum fields "Alignment" and "Initial value" are now correctly enabled and disabled. 
 

Ver:   5.4.0 EW20486 
The value of bit field variables located in the anonymous structure/union could be incorrectly shown 
in the Live Watch window. This has been corrected. 
 

Ver:   5.4.0 EW20397 
It is now possible to resize the Goto Function dialog of the Text Editor. The function list in the dialog 
is also sorted alphabetically. 
 

Ver:   5.4.0 EW20269 
The C-SPY macro "   openFile ( input_file, "r+b" )" could fail if the input_file had the read only 
attribute set. This has been corrected. 
 

Ver:   5.4.0 EW20237 
There was no way to select the checksum algorithm sum32 in "Project>Options>Linker>Checksum". 
This has been corrected. 
 

Ver:   5.4.0 EW20108 
When the execution has stopped at a breakpoint, the corresponding breakpoint entry in the 
Breakpoints window is marked by the green arrow. 
 

Ver:   5.3.4 EW20940 
The debugger could become unresponsive when attempting to display large floating-point values. 
This has been corrected. 
 

Ver:   5.3.3 EW20668 
The "Clean" command sometimes failed to remove compiler-generated list files. This has been 
corrected. 
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Ver:   5.3.3 EW20660 
It was impossible to browse to a location in the source file when creating a new code breakpoint. 
This has been corrected. 
 

Ver:   5.3.3 EW20546 
Value of 64-bits large double numbers could be incorrectly displayed when using the default display 
format. This has been corrected. 
 

Ver:   5.3.3 EW20497 
An incorrect $ variable like $FILE_PATHB$ used in custom build definitions could lead to crash. This 
has been corrected. 
 

Ver:   5.3.3 EW20202 
The sizes of the windows in the IAR Embedded Workbench IDE were not restored properly if the 
application was minimized when it was closed. 
 

Ver:   5.3.3 EW19825 
If a debug file has changed between sessions, all absolute user breakpoints are disabled and a log is 
issued to this effect. 
 

Ver:   5.3.3 EW19178 
If the IAR Embedded Workbench IDE was placed partly outside the screen or minimized when it was 
closed the dialog box asking for confirmation of termination of a debug session could appear outside 
the screen. 
 

Ver:   5.3.2 EW20573 
The command line utility cspybat.exe downloaded code to memory after the flashloader download 
which could cause problems in some hardware. This has been corrected. 
 

Ver:   5.3.1 EW20530 
The flashloader based on a previous flashloader framework could not properly be invoked from 
Cspybat.exe. This has been corrected. 
 

Ver:   5.3.1 EW20425 
If an input expression in the "Linker configuration file editor" dialog box contained space or tab 
characters, it could be incorrectly evaluated to 0. This has been corrected. 
 

Ver:   5.3.1 EW20339 
Opening the Code Coverage window in the Japanese language version no longer causes the 
Embedded Workbench IDE to exit unexpectedly. 
 

Ver:   5.3.0 EW20112 
Circular #include preprocessor directives could make the IDE unresponsive. This has been corrected. 
 

Ver:   5.3.0 EW20103 
A multiple failure to open a file using the 'fopen()' library function could use up all available file 
handles. This no longer occurs. 
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Ver:   5.3.0 EW20039 
C-SPY no longer crashes when accessing certain pointer-to-member variables. 
 

Ver:   5.3.0 EW19869 
Some RealView 3.1 generated ELF/DWARF formatted files could be incompatible with C-SPY 
debugger. This resulted in an error: 
 
ELF/DWARF Error: Unsupported .debug_info format version:5660 
 
This has been corrected. 
 

Ver:   5.3.0 EW19816 
An illegal instruction executed in a tight loop generated an excessive warning output to the Debug 
Log window. This could render the debugger unresponsive. This has been corrected. 
 

Ver:   5.3.0 EW19748 
The fill pattern can now be of any length as long as it is composed of full bytes, but must be given in 
hexadecimal notation, starting with 0x. 
 

Ver:   5.2.9 EW19880 
The Embedded Workbench IDE could terminate abnormally if the application JAWS from Freedom 
Scientific was running concurrently. This has been corrected. 
 

Ver:   5.2.8 EW20152 
In some cases, evaluating variables of the type complex structures, for example via ToolTip, could 
lead to an abnormal termination of the IDE session. This has been corrected. 
 

Ver:   5.2.7 EW20133 
A modulo operator with a 0 divisor within preprocessor directives could cause the IDE to terminate 
abnormally. This has been corrected. 
 

Ver:   5.2.5 EW19942 
The "New Breakpoint..." dialog would occasionally become too large, partially hiding window 
contents. This has been corrected. 
 

Ver:   5.2.5 EW19806 
An incorrect preprocessor directive in the form of 
 
#define X(y) #x 
 
could make the Embedded Workbench terminate abnormally. This has been corrected. 
 

Ver:   5.2.0 EW20179 
The workspace file did not save relative paths to project files that were outside/above the workspace 
directory. This has been corrected. 
 

Ver:   5.2.0 EW19877 
Builds no longer fail if the paths of any of the output directories use the $WS_DIR$ variable. 
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Ver:   5.1.1 EW19773 
The IAR Embedded Workbench IDE could become unresponsive if recursive macros were used in a 
preprocessor expression with the "Generate browse information" selected in the IDE options dialog 
box. This has been corrected. 
 

Ver:   5.1.1 EW19771 
If you open the Find in Files dialog box with unsaved files open, you will be asked how to proceed 
with the unsaved files. Previously, if there was selected text in an editor window when you opened 
the Find in Files dialog box, it would be deselected after you had taken care of the unsaved files. This 
has now been corrected, and the selection still exists when you return to the Find in Files dialog box. 
 

Ver:   5.1.1 EW19623 
The Build log file now contains also the file name and line number where applicable. 
 

Ver:   5.1.0 EW20114 
Editor "Go to Function" failed in code containing "namespace". This has been corrected. 
 

Ver:   5.1.0 EW19704 
Selecting the "Treat all warnings as errors" linker option generated multiple "--warnings_are_errors" 
flags to ILINK. 
 
This has been corrected. 
 

Ver:   5.1.0 EW19689 
The project manager maintains a number of variables, such as $PROJ_DIR$ or $TOOLKIT_DIR$, which 
can be used in project options (and other places) and which are expanded to strings as appropriate. If 
you specify a variable on the form $_NAME_$, it will now be expanded to the value of the 
environment variable named NAME. 
 

Ver:   5.1.0 EW19670 
A source line containing only '#define' but nothing more could cause the IAR Embedded Workbench 
IDE to exit abnormally. This has been corrected. 
 

Ver:   5.1.0 EW19625 
A problem with adding additional libraries on the ILINK "Library" page has been corrected. 
 

Ver:   5.1.0 EW19619 
If a .c file contains a time stamp, using the    TIME    macro, it is desirable that the file is recompiled 
each time a project is built. One easy way to accomplish this is to render the .c file "not up to date" in 
the prebuild build action (in the Project>Options dialog.), for example by using 'touch' on the source 
file or removing the object file. A bug has been fixed which prevented this technique from working 
properly (it used to require two invocations of Make to bring a project up to date). 
 

Ver:   5.1.0 EW19615 
Tooltips for variables in the editor window now reflect the global default integer format. 
 

Ver:   5.1.0 EW19614 
When a debug session is active, files will now normally open in the built-in text editor even if an 
external editor has been specified. 
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Ver:   5.1.0 EW19609 
The pragma directive "#warning" is now correctly highlighted by the text editor. 
 

Ver:   5.1.0 EW19608 
The    openFile C-SPY macro function can now use the value "b" for the access parameter to open 
files in binary mode. This makes it possible for the C-SPY macro function    writeFileByte to handle 
binary files correctly. Allowed     openFile access parameter combinations are: 
r, r+, rb, rt, rb+, rt+, r+b, r+t 
a, a+, ab, at, ab+, at+, a+b, a+t 
w, w+, wb, wt, wb+, wt+, w+b, w+t 
 

Ver:   5.1.0 EW19607 
The    openFile C-SPY macro function can now use the value "b" for the access parameter to open 
files in binary mode. This makes it possible for the C-SPY macro function    readFileByte to handle 
binary files correctly. Allowed     openFile access parameter combinations are: 
r, r+, rb, rt, rb+, rt+, r+b, r+t 
a, a+, ab, at, ab+, at+, a+b, a+t 
w, w+, wb, wt, wb+, wt+, w+b, w+t 
 

Ver:   5.1.0 EW19590 
Symbol #CYCLES is now also available when debugging files in intel-extended and motorola formats 
using simulator 
 

Ver:   5.1.0 EW19576 
A problem with file sharing violations between the Source Browser and Find in Files has been 
corrected. 
 

Ver:   5.1.0 EW19566 
Problems with entering multiple lines of text in the Check-In dialog comment field has been 
corrected. 
 

Ver:   5.1.0 EW19562 
A number of key bindings issues have been fixed. 
 

Ver:   5.1.0 EW19556 
When navigating in the Source Browser by typing the first few letters of a symbol, the topmost item 
(the project name) is now ignored. 
 

Ver:   5.1.0 EW19552 
Changing output directories could temporarily result in build problems. This has been corrected. 
 

Ver:   5.1.0 EW19543 
In some cases, references were incorrectly shown in the QuickWatch, Watch and Locals windows. 
This has been corrected. 
 

Ver:   5.1.0 EW19532 
If you based a new project build configuration on an old configuration, and the project contained 
files that had been excluded from the old configuration, these files would incorrectly be included in 
the new configuration. This has been corrected. 
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Ver:   5.1.0 EW19531 
The editor function browser did not recognize functions within the 'namespace' block. This has been 
corrected. 
 

Ver:   5.1.0 EW19523 
The text editor now reloads externally modified files correctly. 
 

Ver:   5.1.0 EW19486 
Deselecting "Automatic runtime library selection" will now add the "--no_library_search" options to 
the ILINK command line. 
 

Ver:   5.1.0 EW19464 
C-SPY no longer crashes if a C-SPY macro invoked by a breakpoint deletes the very same breakpoint. 
 

Ver:   5.1.0 EW19461 
If there are unsaved files when the building of a project is started, you are now given a chance to 
save none/all/some of the files or cancel the operation. 
 

Ver:   5.1.0 EW19455 
Division by 0 within preprocessor directives could cause IAR Embedded Workbench to terminate 
abnormally. This has been corrected. 
 

Ver:   5.1.0 EW19448 
The ILINK configuration file editor no longer loses data at the end of the file each time it is edited. 
 

Ver:   5.1.0 EW19371 
It is now possible to choose a background color for editor windows. 
 

Ver:   5.0.1 EW19535 
While debugging, multiple instances of the same file could be opened if its path contained non-ASCII 
characters. This has been corrected. 
 

Ver:   5.0.1 EW19459 
In some situations the Embedded Workbench could crash when the Find in Files dialog was opened. 
This has been corrected. 
 

Ver:   4.8.4 EW19783 
Problems with entering multiple lines of text in the Check-In dialog comment field has been 
corrected. 
 

Ver:   4.8.4 EW19235 
Tool-tip watch, 'Quick Watch' and 'Add to Watch' did not work unless the function or variable was 
marked. This has been corrected. 
 

Ver:   4.8.3 EW19007 
In some situations, edit boxes were left unclosed when repeatedly clicking in a window with editable 
contents. 
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Ver:   4.8.3 EW18927 
Clicking the vertical scrollbar in the Disassembly window multiple times could earlier lead to incorrect 
behavior. 
 

Ver:   4.8.3 EW18891 
Floating windows placed on the secondary monitor outside the IAR Embedded Workbench IDE main 
window will now be centered on the primary display monitor if moving from a system with two 
display monitors. 
 

Ver:   4.8.3 EW18726 
When a project file is opened, the IDE now detects if it has been modified since it was last opened, 
and if so, will make the next build a complete rebuild. 
 

Ver:   4.8.3 EW18660 
In a custom build rule, the files listed in "Additional input files" were not always checked correctly 
when determining if the rule should be applied during a build operation. This has been corrected. 
 

Ver:   4.8.3 EW18314 
Using nested C++ types in the following code example no longer leads to abnormal debugger 
termination. 
 
Example: 
 
template <class T> 
class A 
{ 
T* data; 
}; 
class B : public A<B> 
{ 
}; 
int main(void) 
{ 
B b; 
return 0; 
} 
 

Ver:   4.8.3 EW13522 
The project manager now detects when open project files are modified on disk, and gives an 
opportunity to reload them. 
 

Ver:   4.8.1 EW19018 
When downloading or restoring the memory contents from a Motorola S37 formatted file, the 
highest address byte was always set to 0. This has been corrected. 
 

Ver:   4.8.0 EW18946 
The IAR Embedded Workbench no longer crashes when you type a colon or a semicolon followed by 
a return character in an otherwise empty source file. 
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Ver:   4.8.0 EW18746 
A very rare problem in IAR Embedded Workbench, that could delete project files if a project directory 
was moved, has been corrected. 
 

Ver:   4.8.0 EW16369 
A problem where the Profiling plug-in module did not remember its state has been corrected 
 

Ver:   4.7.2 EW18554 
The debugger no longer terminates abnormally if the Profiling functionality is activated and when 
there are too few breakpoints available. 
 

Ver:   4.7.1 EW18463 
Placing a variable using the '@' operator at an address outside the defined address space could cause 
the debugger to exit unexpectedly. This has been corrected. 
 

Ver:   4.7.1 EW18358 
Adding a trailing semicolon to the 'File types' list box in the Find in Files dialog box, no longer causes 
the IAR Embedded Workbench IDE to exit unexpectedly. 
 

Ver:   4.7.1 EW18352 
If the debugger, when terminating a debug session, failed to stop the target execution, a crash could 
occur. This has been corrected. 
 

Ver:   4.7.1 EW18351 
Missing a swtdXXX.dll file no longer causes project files to be backed up every time the project is 
opened. 
 

Ver:   4.7.1 EW18340 
A problem where the Stack window could cause a crash when a debug session started has been 
corrected. 
 

Ver:   4.7.1 EW18329 
Flash loader warnings in the debugger log were easy to miss among all other log output, which could 
make errors difficult to understand. This has been corrected. 
 

Ver:   4.7.1 EW18309 
In some cases, stopping at a step point in highly optimized code could make the Embedded 
Workbench IDE exit with no warning. This has been corrected. 
 

Ver:   4.7.1 EW18212 
The Watch window, and related windows, no longer scroll to the top of the list when stepping or 
expanding large structures or arrays. 
 

Ver:   4.7.1 EW17411 
C-SPY no longer crashes when trying to load a file in the unsupported ELF/DWARF format. The file is 
rejected and a debug session is not started. 
 

Ver:   4.7.1 EW17239 
Expanding an STL data structure in the Watch window of the debugger, when the data structure fits 
entirely in a processor register, no longer causes a crash. 
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Ver:   4.7.1 EW16661 
A problem with keeping user-defined key bindings has been corrected. 
 

Ver:   4.7.1 EW16421 
A source browser filter for non-member functions and variables has been added. 
 

Ver:   4.7.1 EW16393 
The driver SDK has been modified to allow for some more flexibility in managing threads, as follows: 
* The documentation now describes from which threads each driver function can be called. 
* The built-in critical section locks in DpDriver are now optional. 
* The background execution thread now gets specific sign on/off calls using DbDriverCmd. 
 

Ver:   4.7.1 EW16392 
The driver SDK has been modified to allow for some more flexibility in managing threads, as follows: 
* The documentation now describes from which threads each driver function can be called. 
* The built-in critical section locks in DpDriver are now optional. 
* The background execution thread now gets specific sign on/off calls using DbDriverCmd. 
 

Ver:   4.7.0 EW18077 
The Auto Indent function now better handles lines already indented using tabs (could also cause a 
crash in unusual circumstances.) 
 

Ver:   4.7.0 EW18068 
In some cases the display of STL objects in a readable format did not work. This has been corrected. 
 

Ver:   4.7.0 EW17983 
 
If the debugger is in source level stepping mode a green arrow is only shown for the current PC in the 
editor window. If the debugger is in assembly level stepping mode the green arrow is only shown in 
the disassembly window. 
 
The green arrow that points at the current source location is now only visible in one of the text editor 
and the disassembly window. It is in the text editor if the debugger is in statement stepping mode 
and in the disassembly window if it is in step point stepping mode. 
 

Ver:   4.7.0 EW17951 
Specifying output directories with a path that contained an illegal drive letter could cause the IAR 
Embedded Workbench IDE to exit abnormally. This has been corrected. 
 

Ver:   4.7.0 EW17780 
If a function was placed using the @ operator, the function was not present in the "Go to Function" 
list. This has been corrected. 
 

Ver:   4.7.0 EW17651 
A problem with misplaced bracket match indicators and bookmarks on lines containing tabs (ASCII 
character 0x09) has been corrected. 
 

Ver:   4.7.0 EW16793 
A horizontal scrollbar has been added to the MISRA C options list. 
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Ver:   4.7.0 EW16753 
When an example workspace was opened from the Startup screen, a different workspace that the 
selected could appear. This has been corrected. 
 

Ver:   4.7.0 EW16235 
By default, the debugger used disassembly level stepping. It now uses source level stepping by 
default if there is source code where the execution stops for the first time. 
 

Ver:   4.7.0 EW16112 
A problem with parsing errors producing strange error messages like: 
 
Thu May 11 11:03:17 2006: [syntax error, unexpected HEXCONSTANT, expecting IDENTIFIER] 
<internal> line 1, column 23 
 
or 
 
Thu May 11 11:03:17 2006: [syntax error, unexpected TYPE_NAME, expecting IDENTIFIER] <internal> 
line 1, column 55 
 
while loading the 'custom_formats.dat' file, has been corrected. ('custom_formats.dat' file contains a 
set of C-SPY macros used to display STL objects in a readable format). 
 

Ver:   4.7.0 EW11887 
A new "Statics" window has been added for inspecting variables with static storage duration. 
 

Ver:   4.6.7 EW18129 
Saving files over a network could sometimes take more than 10 seconds per file. This has been 
corrected. 
 

Ver:   4.6.4 EW17891 
The Stack plugin no longer locks the debugger up when attempting to display stack variables of struct 
type with trailing padding or variables of certain union types. 
 

Ver:   4.6.4 EW17843 
The settings for the Stack plugin are now saved with each project, so it is possible to maintain 
different settings for different projects. 
 

Ver:   4.6.4 EW17826 
 
It is possible now to reset the target system without stopping the execution first. This applies only to 
drivers that support this feature. 
 

Ver:   4.6.4 EW17824 
When saving project files (and some other files) file paths are made relative to either $PROJ_DIR$ 
(the directory where the project file resides) or $EW_DIR$ (the Embedded Workbench installation 
directory). $EW_DIR$ will now only be used if the path refers to a file "under" $EW_DIR$ AND the 
"distance" from $EW_DIR$ is shorter than the distance from $PROJ_DIR$. 
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Ver:   4.6.2 EW17747 
In previous versions of IAR Embedded Workbench, installing a new IAR Embedded Workbench 4.6.0 
product in the same directory where a different IAR Embedded Workbench 4.0-4.5 product was 
already installed could in some cases cause compatibility problems when using the old product. 
 

Ver:   4.6.2 EW17668 
Stepping over statements that generate no code bytes could lead to the unexpected termination of 
IAR Embedded Workbench. This has been corrected. 
 

Ver:   4.6.2 EW17642 
When source browse information generation was enabled, the source browser could sometimes 
enter an infinite loop. This has been corrected. 
 

Ver:   4.6.2 EW17574 
The Disassembly window now properly filters away certain irrelevant internal labels. 
 

Ver:   4.6.2 EW17563 
Having a single identifier at the end of a source file could cause IAR Embedded Workbench to crash. 
This has been corrected. 
 

Ver:   4.6.0 EW17517 
It is now possible to edit the search path in the Find in Files dialog box. 
 

Ver:   4.6.0 EW17416 
Block operations, such as "trim trailing blanks" and "indent block" are performed much faster on 
large files now. 
 

Ver:   4.6.0 EW17370 
Default selected button is "Find next" instead of "Close" so that you with "Enter" can find the next 
hit. 
 

Ver:   4.6.0 EW17369 
Pressing ESC in the Incremental Search dialog used to move the cursor back to where it was before 
the search started. It now leaves the cursor where it is. 
 

Ver:   4.6.0 EW17367 
A command for commenting and uncommenting blocks of code has been added. 
 

Ver:   4.6.0 EW17366 
Workspace and project files are now (optionally) saved before a project is built. 
 

Ver:   4.6.0 EW17365 
The file dialog now remembers the last file type selection. 
 

Ver:   4.6.0 EW17251 
There is now a menu insertion point where plugins can register their about box menu commands. 
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Ver:   4.6.0 EW17219 
Previously, some hardware debugger drivers could only be used from within the IAR Embedded 
Workbench IDE, and not from the command line. These drivers can now be used also from the 
command line. 
 

Ver:   4.6.0 EW17112 
When auto indenting, the editor now uses tabs and/or spaces as determined by editor settings. 
 

Ver:   4.6.0 EW16989 
The iarbuild command line tool now has an option to filter build messages by severity. 
 

Ver:   4.6.0 EW16858 
It is now possible to add custom file types in the Find in Files dialog 
 

Ver:   4.6.0 EW16336 
The text editor now indicates an appropriate line width for printing, either based on a user-settable 
fixed number of characters or on the current printer page width. 
 

Ver:   4.6.0 EW15740 
The Live Watch window could be opened even if the C-SPY driver did not support it. This has been 
corrected but still could appear when using older drivers. 
 

Ver:   4.6.0 EW14458 
It is now possible to toggle breakpoints by double-clicking the left margin in the text editor. 
 

Ver:   4.6.0 EW13708 
When copying text from the ASCII part of a memory window NULL characters ('\0') were removed. 
They now become dots in the clipboard. 
 

Ver:   4.5.1 EW17361 
After initially displaying "Collecting information...' the Source Browser window could show no more 
information. This has been corrected. 
 

Ver:   4.5.1 EW17323 
The IDE no longer crashes if you try to split an editor window directly after the debugger has been 
started or stopped. 
 

Ver:   4.5.1 EW17086 
When source browse information generation was enabled, saving a text editor file could sometimes 
fail. This has been corrected. 
 

Ver:   4.5.0 EW16951 
A program error which caused incorrect Find in Files search results for files with lines exceeding 255 
characters has been corrected. 
 

Ver:   4.5.0 EW16893 
Source browser data was not collected when using the '$FILE_DIR$' argument variable to specify 
additional include paths for the compiler. 
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Ver:   4.5.0 EW16834 
If you had a read-only file open in the editor and chose the Save As command from the Edit menu 
you were asked if you wanted to remove the read-only attributes of the file, and if you said yes the 
original read-only file will be overwritten without showing you a Save As dialog. 
 

Ver:   4.5.0 EW16825 
Stepping through your application program containing multiple C/C++ statements within a single 
preprocessor macro could earlier cause the debugger to terminate abnormally. This has been 
corrected. 
 

Ver:   4.5.0 EW16763 
When saving a workspace file failed, for example if it was write protected, an error message was not 
displayed. 
 

Ver:   4.5.0 EW16750 
IAR Embedded Workbench could earlier not handle paths with more than one space. 
 

Ver:   4.5.0 EW16742 
Source browse information for functions declared using the #pragma location directive or the @ 
operator was incorrectly displayed in the Source Browser window. 
 

Ver:   4.5.0 EW16738 
In the workspace window there is a new popup menu command for adding the topmost editor 
document to the current project. 
 

Ver:   4.5.0 EW16732 
Loading of large projects, or specifically projects with large dependency files (.dep), has been 
speeded up considerably. 
 

Ver:   4.5.0 EW16728 
Source browse information for an #if preprocessor directive containing a macro with parameters was 
incorrectly displayed in the Source Browser window. 
 

Ver:   4.5.0 EW16720 
The Auto window incorrectly displayed certain nested expressions as "TBD". 
 

Ver:   4.5.0 EW16700 
In some cases, the debugger could earlier fail to clear temporary breakpoints set to control the 
execution of the flash loader. This has been corrected 
 

Ver:   4.5.0 EW16650 
The build log and the text editor have now different images for errors and warnings. 
 

Ver:   4.5.0 EW16605 
If you selected a cursive font like "Monotype Corsiva", all fonts selected thereafter also became 
cursive. 
 

Ver:   4.5.0 EW16578 
There is now a context menu command for opening a file included with an include statement in 
c/cpp code. It is also be possible to jump between source and include files with the same name. 
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Ver:   4.5.0 EW16540 
When a bracket is entered or the caret is placed after a bracket in the text editor the matching 
bracket is highlighted. 
 

Ver:   4.5.0 EW16265 
When closing a workspace file containing a read-only project file, an error message was displayed but 
without the possibility to save the project file. 
 

Ver:   4.5.0 EW14776 
In the debugger, a memory attribute is sometimes needed when casting to a pointer type. The error 
message issued when the attribute is missing is now clearer. 
 

Ver:   4.5.0 EW14285 
To simplify examining variables defined in assembler files, assembler labels are now by default 
treated as variables of type int, located at the label location, instead of as integer constants with the 
label address as the value. The display can be further customized using context menus in e.g. the 
Watch debugger window. 
 

Ver:   4.4.2 EW16645 
A problem with source code control operations on Embedded Workbench projects connected to 
Microsoft Visual SourceSafe has been corrected. Now all operations can be performed on the 
projects. 
 

Ver:   4.4.2 EW16579 
A problem when terminating execution of CSpyBat.exe using ctrl-c has been corrected. 
 

Ver:   4.4.1 EW16449 
A problem that sometimes caused the IDE to crash when old projects were opened has been 
corrected. 
 

Ver:   4.4.1 EW16426 
If a project was placed in the Embedded Workbench installation directory, Find in Files regarded the 
project's files as system include files. This meant that when the option "Project files and user include 
files" (i.e. no system include files) was selected, no files were searched through. 
 

Ver:   4.4.1 EW16348 
The format variant "NEC compatible" for XCOFF78K now sets the '-yspn' flags by default 
 

Ver:   4.4.0 EW16182 
An expression in form of a variable enclosed in redundant parentheses can be properly evaluated 
now 
 

Ver:   4.4.0 EW16137 
The --misrac_verbose option (when turned on) is no longer emitted for each object file on the XLINK 
command line. 
 

Ver:   4.4.0 EW16124 
In some situations the IAR Embedded Workbench could terminate abnormally when the Compiler 
Options dialog box was displayed. 
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Ver:   4.4.0 EW16111 
Run to Cursor no longer fails to stop the execution at the correct location. This could happen for 
certain statements with nested function calls. 
 

Ver:   4.4.0 EW16098 
In some situations the selected editor tab went out of synch with the displayed document. (This 
could happen if many editor tabs were visible and you selected the leftmost one.) When this 
happened it could also make the IAR Embedded Workbench to terminate abnormally. 
 

Ver:   4.4.0 EW16090 
Better default directories are picked for file browsing dialog boxes. 
 

Ver:   4.4.0 EW16072 
The filename and line number are now shown for build errors. 
 

Ver:   4.4.0 EW16071 
The IAR Embedded Workbench no longer terminates abnormally when starting to edit a text file after 
selecting the leftmost editor tab from large number of tabs. 
 

Ver:   4.4.0 EW16015 
C-SPY no longer highlights the wrong call when traversing the call stack. 
 

Ver:   4.4.0 EW15987 
The 'Go to Function' button (in the bottom left corner of editor windows) did not work if syntax 
highlighting was turned off. 
 

Ver:   4.4.0 EW15916 
The text editor context menu no longer displays an inordinate amount of text in the 'Go to definition' 
menu command when the selection is large. 
 

Ver:   4.4.0 EW15635 
The option to choose project files has been put back in the Find in Files dialog box. The dialog box has 
also been redesigned. 
 

Ver:   4.4.0 EW15457 
The asterisk indicating that a workspace or a project contains unsaved changes is now updated 
directly upon a Save All command. 
 

Ver:   4.4.0 EW15228 
Rebuild all could periodically fail on computers with hyper threading enabled 
 

Ver:   4.4.0 EW15208 
There is no longer a problem with selecting a group of files to search thanks to new design of the 
Find in Files window 
 

Ver:   4.4.0 EW15121 
C-SPY can now display pointer-to-member variables. 
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Ver:   4.4.0 EW14796 
The Toggle Breakpoint toolbar button was moved to the off-line toolbar to make it available when 
not debugging. 
 

Ver:   4.3.1 EW15857 
The Break button on the Debugger toolbar could indicate that the debugger was still running even 
after the execution had completed. This has been corrected. 
 

Ver:   4.3.1 EW15843 
Executing the same macro before and after downloading of a debugee could lead to abnormal 
session termination. This has been corrected. 
 

Ver:   4.3.1 EW15765 
Editing memory in the Memory window is now executed group-wise. When you start typing an edit 
box appears with the contents of the part of the memory you are about to modify. The data is not 
written until the box is closed. 
 

Ver:   4.3.1 EW15739 
When inspecting source code in mixed mode on the Output page of the Trace window, focus is no 
longer moved to the corresponding source file. 
 

Ver:   4.3.1 EW15738 
The Trace window did not keep its visual state properly when the window was moved or the debug 
session was restarted. 
 

Ver:   4.3.1 EW15735 
The following Xlink output formats have been removed from list of available formats as obsolete: 
NEC2 
NEC2-symbolic 
NEC78K 
NEC78K-symbolic 
 

Ver:   4.3.1 EW15722 
Non-default formats for items in the Watch window were not saved correctly when exiting the IAR 
Embedded Workbench. This has been corrected. 
 

Ver:   4.3.1 EW15720 
Corrected a problem with limitations in the toolbar search field. 
 

Ver:   4.3.1 EW15638 
Errors in custom build settings could cause annoying repeating error messages in the Build log 
window. Also, certain custom build errors could cause some problems with subsequent builds even 
after being corrected. This has been corrected. 
 

Ver:   4.3.1 EW15614 
When generating an assembler output file from the C compiler, the file should not automatically be 
further processed by the tool chain, even though such a file is normally subject to processing by the 
assembler. In previous versions of the workbench, this was accomplished by simply hiding the 
assembler output file. Now, the file can be seen and conveniently accessed in the project window 
(without being processed.) 
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Ver:   4.3.1 EW15531 
When using the Memory window, the settings were not stored/restored when exiting the debugger 
or the IAR Embedded Workbench. This has now been corrected. 
 

Ver:   4.3.1 EW15515 
When changing output file format for a project, the old output file could remain shown in the 
Workspace window indefinitely. This has been corrected. 
 

Ver:   4.3.1 EW15492 
Adding multiple source files with the same name would cause valid but annoying repeating error 
messages in the Build log window. This has been corrected and now the error message doesn't 
appear until an actual build operation is performed (and it only appears once). 
 

Ver:   4.3.1 EW14817 
When splitting a source window the new window used to show the top of the file. It now shows the 
same part of the file as the original window. 
 

Ver:   4.3.1 EW14774 
File and line number has been put back into the build log window. 
 

Ver:   4.3.1 EW14731 
The Editor now removes trailing blanks when text files are saved. This feature can be switched off on 
the Editor settings page. 
 

Ver:   4.3.1 EW13986 
The project manager can now handle the Compile command for multiple files or for a group. 
 

Ver:   4.3.0 EW15406 
The Break button on the Debugger toolbar could indicate that the debugger was still running even 
after the execution had completed. This has been corrected. 
 

Ver:   4.3.0 EW15391 
A project file could appear more than once in the Workspace window if its pathname was capitalized 
differently. 
 

Ver:   4.3.0 EW15224 
After changing the exclude-from-build property for a file, the project manager did not relink the 
project. This has been corrected. 
 

Ver:   4.3.0 EW15222 
A problem where (in the sizeof operator of the C-SPY macro language) the size of an array variable 
was incorrectly reported as the size of a pointer to its element type has been corrected. 
 

Ver:   4.3.0 EW15221 
In C-SPY expressions, some registers with "complex" names couldn't be accessed using the #name or 
#`name` syntax. This has been corrected. 
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Ver:   4.3.0 EW15203 
When removing a file from a project, the project manager did not relink the project. This has been 
corrected. 
 

Ver:   4.3.0 EW15159 
Tab characters were treated as unprintable in the Message window. Now they are output as space 
characters. 
 

Ver:   4.3.0 EW15141 
A problem where C-SPY could not load a macro file containing a macro with an empty function body 
has been corrected. 
 

Ver:   4.3.0 EW15137 
A plain assignment in C-SPY expressions, such as x=42, no longer causes reading of the left-hand side. 
 

Ver:   4.3.0 EW15108 
Some plug-ins could not open their windows or opened the Help window instead. This has been 
corrected. 
 

Ver:   4.3.0 EW15101 
Pressing F1 in the C-SPY Live Watch window displayed help for the Watch window. This has been 
corrected. 
 

Ver:   4.3.0 EW15058 
Execution of Reset command is now indicated in Trace output window 
 

Ver:   4.3.0 EW14851 
If there was no valid backtrace information, source-level step operation could run to exit when 
leaving a function. This has been corrected. 
 

Ver:   4.3.0 EW14221 
The default filter in "Add Files" dialog does not include header files now. 
 

Ver:   4.2.1 EW15354 
Because of initialization file corruption, sometimes the Disassembly window could appear even when 
no debugger session was active. This problem, which could result in an internal error for hardware 
debugger systems, has been corrected. 
 

Ver:   4.2.1 EW15291 
In some cases, not all zones were listed in the Breakpoints dialog box for breakpoints at an absolute 
address. This has been corrected. 
 

Ver:   4.2.0 EW15450 
A problem with the fact that IAR Embedded Workbench becomes unresponsive after switching 
projects several times has been corrected. The problem was caused by incorrect saving of floating 
window(s) desktop information, which led to uncontrolled growth of the debugger desktop (.dbgdt) 
file. 
 

Ver:   4.2.0 EW15037 
Sometimes, data coverage coloring failed for hardware debugger systems. This has been corrected. 
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Ver:   4.2.0 EW15028 
When a legacy project file (with the extension .prj or .pew) was opened, the IDE sometimes crashed 
directly after the project file was converted to the current format. This problem has been corrected. 
 

Ver:   4.1.1 EW14377 
It is now possible to activate a single interrupt through mouse click when running a simulator driver. 
 

Ver:   4.0.0 EW14256 
Improved visualization of the C-source lines in the Disassembler window by adding a color to the 
debugger option. 
 

Ver:   4.0.0 EW14108 
Snapping to a step point works now across the line border. That means that toggling a breakpoint at 
a source line that does not contain any step points results in a breakpoint set/clear at the nearest 
step point below. If there is no such step point no breakpoint will be set/cleared. 
 

Ver: EW19468 
The text editor now reloads externally modified files correctly. 
 

Ver: EW19458 
Division by 0 within preprocessor directives could cause IAR Embedded Workbench to terminate 
abnormally. This has been corrected. 
 

Ver: EW19318 
Japanese version of code templates file was saved using improper encoding. This has been corrected. 


